ARCPLS STAFF DEVELOPMENT DAY
Our staff spend the day being trained on topics such as transforming story times, enhancing information literacy, and learning how we can best serve our patrons who are less fortunate. Our mission is to enrich the lives of the community, and we look forward to doing this for years to come!

ARCPLS HOSTS RIBBON CUTTING OF AUGUSTA SECOND CHANCE DESK
ARCPLS has partnered with the Augusta Judicial Circuit District Attorney’s Office, the Richmond County Solicitor General’s Office, the Burke County Solicitor General’s Office, and the Georgia Justice Project to announce the opening of the Augusta Second Chance Desk. We celebrated the opening of this program with our partners and leaders and members of the community.

The Second Chance Desk will serve individuals with records in Richmond and Burke counties who are experiencing barriers to employment or housing or other opportunities due to old arrests.

NATIVE AMERICAN HERITAGE MONTH
A collection of films honoring culture & history.
BIG BOOK SALE AT THE AUGUSTA LIBRARY

A huge variety of books of different genres and reading levels will be available at a reduced price and much more! The Friends Shop will be open for purchase of their sturdy and fashionable tote bags and additional selections.

PUBLIC PARTICIPATION IN LIBRARY DECISION MAKING

The Augusta-Richmond County Public Library System invites the community to attend library board meetings that are held in compliance with the City of Augusta’s rules and regulations. Any person or group who wishes to speak to the library board should contact the library director in advance. The library director maintains an open-door policy and welcomes phone calls, letters and visits from patrons.

Launchpad tablets help kids become CONFIDENT READERS. Borrow one from your local library today.
Children’s

• Monday, November 20 at 11:00 am
  Special Thanksgiving Sensory Storytime!
  Program room. Please join us for a special Sensory Storytime just in time for
  Thanksgiving.

• Wednesday, November 22 at 11:00 am
  Be Thankful Storytime and Craft
  Join us for a festive storytime and craft to celebrate the Thanksgiving holiday. Best for
  ages 3 and up.

Young Adults

• Wednesday, November 15 from 5:30 pm to 7:30 pm
  NaNoWriMo Come Write-In HQ Auditorium.
  Tackle National Novel Writing Month (NaNoWriMo) with us in a supportive
  environment as you write your novel, memoir, or another writing project. Light
  refreshments will be served. Throughout November, come to the library for a quiet
  place to write as well as for library resources. Learn more about National Novel Writing
  Month at https://www.nanowrimo.org/. Best for ages 12 years and up (teens and adults)

• Saturday, November 18 from 10:30 am to 12:30 pm
  DIY Holiday Gifting: Acrylic Paint Pouring Edition
  HQ Auditorium. Want to make your own holiday gifts this season? If so, come learn
  how fun and easy it is to create unique gifts using the acrylic paint pouring technique
  on canvases, ceramic tiles, and ornaments. Best for ages 8 years and up (children,
  teens, and adults). Call 706-821-2627 to register.

• Sunday, November 19 from 2:30 pm to 4:30 pm
  DIY Holiday Gifting: Body Scrubs and Bath Bombs
  HQ Auditorium. For day 2 of our holiday gifting series, come create body scrubs and
  bath bombs that you can keep for yourself or gift to someone special. Best for ages 8
  years and up (children, teens, and adults). Call 706-821-2627 to register.
NOVEMBER PROGRAMS FOR ARCPLS

Augusta Library

Adults

- **Monday, November 13 from 6 pm to 7 pm**
  *Between the Ink – Anime Viewing (Campfire Cooking in Another World)*
  
  3rd Floor Meeting Space. Join us for the viewing of this fun cooking related anime filled with lots of laughs and delicious looking recipes. We’ll view the first few episodes of the series. Animes shown have accompanying manga available in PINES! Light Refreshments to be served. Call (706) 821-2627 to register or drop in!

- **Wednesday November 8 (9 am – Noon) & November 15 (2 pm – 5 pm)**
  *1 on 1 Tech Help*

  Do you need help with the basics of navigating your personal mobile devices? Would you prefer to have a personal one on one session? Then call (706) 821-2627 to call & register and learn more about our 30 min tech help sessions. Please note that sessions are by availability and if one session is full, you have

Georgia Heritage Room

- **November – December 2023**
  *This Old House: Folk Architecture of the Former Towns of Savannah River Site, 1950-1951*

  A collection of photographs and artifacts on loan from Savannah River Archaeological Research Program exploring the variety of architectural styles that made up the once thriving communities of Ellenton, Dunbarton, Hawthorn, and other small locales prior to the construction of Savannah River Site.

All Ages

- **Wednesday, November 15 from 5:30 pm to 7:30 pm**
  *NaNoWriMo Come Write-In*

  HQ Auditorium. Tackle National Novel Writing Month (NaNoWriMo) with us in a supportive environment as you write your novel, memoir, or another writing project. Light refreshments will be served. Throughout November, come to the library for a quiet place to write as well as for library resources. Learn more about National Novel Writing Month at https://www.nanowrimo.org/. Best for ages 12 years and up (teens and adults).

- **Saturday, November 18 from 10:30 am to 12:30 pm**
  *DIY Holiday Gifting: Acrylic Paint Pouring Edition*

  HQ Auditorium. Want to make your own holiday gifts this season? If so, come learn how fun and easy it is to create unique gifts using the acrylic paint pouring technique on canvases, ceramic tiles, and ornaments. Best for ages 8 years and up (children, teens, and adults). Call 706- 821-2627 to register.
NOVEMBER PROGRAMS FOR ARCPLS

• Sunday, November 19 from 2:30 pm to 4:30 pm
  DIY Holiday Gifting: Body Scrubs and Bath Bombs
  HQ Auditorium. For day 2 of our holiday gifting series, come create body scrubs and
  bath bombs that you can keep for yourself or gift to someone special. Best for ages 8
  years and up (children, teens, and adults). Call 706-821-2627 to register.

Appleby Branch Library

Children’s

• Saturday, November 4 & 25 at 10:30 am
  Crafty: Make or Take
  Join us at Appleby to make a craft or stop by and pick up a craft kit while supplies
  last. Best for ages 6 and up.

• Monday, November 6 at 4:00 pm
  Adventures in Book Land
  Join us as we celebrate our love of reading, share your favorite author or book with
  us. We’ll share books we love, do activities and more. Best for ages 7 and up.

• Tuesday November 7 at 3:30 pm
  Veteran’s Day Activity at Appleby! Join us at the Appleby Branch for a Veteran’s
  Day Activity. Ages 3 and up. Registration Required: 706-736-6244

• Wednesday, November 8 at 4:00 pm
  Greeting Cards: DIY Crafts for Kids
  Join us at Appleby as we make our own Greeting Cards. Best for ages 5-11.
  Registration Required: 706-736-6244.

• Tuesday, November 14 at 4 pm
  Design Tech: Design and Create a Greeting Card Join us as we learn how to design
  and create a greeting card. Ages 7 and up. Registration Required: 706-736-6244

• Wednesday, November 15 at 4:00 pm
  STEM Challenge
  Join us at Appleby as we take on a STEM challenge, what will we learn about today?
  Ages 7 and up. Registration Required: 706-736-6244

Young Adults

• Tuesday, November 7 at 4:00 pm
  Teen Tech Help
  Bring your device - phone, tablet, laptop, etc. and receive one-on-one assistance from
  library staff. Best for ages 12-18. Registration Required: 706-736-6244

• Monday, November 20 at 4:00 pm
  Book Smart
  Join us as we celebrate our love of reading, share your favorite author or book with us.
  We'll share books we love, do activities and more. Best for ages 12-18.
NOVEMBER PROGRAMS FOR ARCPLS

Adults

- **Tuesday, November 7 at 10:30 am**
  **Senior Tech Tip & Help**
  Bring your device - phone, tablet, laptop, etc. and receive one-on-one assistance from library staff. Registration Required: 706-736-6244 Monday, November 13 at 4:00 pm
- **Cookbook Bites - “Salt Fat Acid Heat” by Samin Nosrat** Join us at Appleby for a cookbook book club. We’ll share our favorites recipes from the cookbook as well as other tidbits. We’re reading “Salt Fat Acid Heat” by Samin Nosrat. For more information call 706-736-6244.

- **Monday, November 13 at 4:00 pm**
  **Cookbook Bites – “Salt Fat Acid Heat” by Samin Nosrat**
  Join us at Appleby for a cookbook book club. We’ll share our favorites recipes from the cookbook as well as other tidbits. We’re reading “Salt Fat Acid Heat” by Samin Nosrat. For more information call 706-736-6244.

- **Monday, November 27 at 4:00 pm**
  **As the Page Turns - "Remarkably Bright Creatures" by Shelby Van Pelt**
  Are you an adult who loves to read? Come by Appleby as we discuss this month's book club read - "Remarkably Bright Creatures" by Shelby Van Pelt! For more information call 706-736-6244.

Friedman Branch Library

Children’s

- **Chess Wednesdays**
  4:00 pm - 5:00 pm
  Come with a partner and play a game of chess. Chess board provided.

- **Lego Play Wednesdays**
  4:00 pm - 5:00 pm
  Come create a Lego masterpiece. It will be displayed in the library. Legos are provided.

- **Tuesday from 10 am - 11 am**
  **Storytime Every**
  Join us weekly on Tuesday for story time. Pre-register at 706-736-6758.

- **Game On All Day Monday**
  **November 20**
  Board games and trivia contests will be available for play.

- **November 20**
  **Sidewalk Art All Day Monday**
  Create sidewalk masterpieces with chalk.
NOVEMBER PROGRAMS FOR ARCPPLS

Young Adults

- **Chess Wednesdays**
  4:00 pm - 5:00 pm
  Come with a partner and play a game of chess. Chess board provided.

- **November 4 from 11:00 am to 12:00 pm**
  **Fall Treasure Hunt Saturday**
  Come out and join us for a Fall themed treasure hunt. Figure out the riddles to find the hidden prize. You don’t want to miss out on this fun event! Registration Required; 706-736-6758.

- **Monday, November 20 at 4:00 pm**
  **Book Smart**
  Join us as we celebrate our love of reading, share your favorite author or book with us. We’ll share books we love, do activities and more. Best for ages 12-18.

Adults

- **Thursday, November 2, 9, 16, 30 10:00 am to 11:00 am**
  **One-on-One Tech Help**
  Bring your device - phone, tablet, laptop, etc., - and receive one-on-one assistance from library staff. Registration required due to limited space. Pre-register at 706-736-6758.

**Maxwell Branch Library**

Children’s

- **Tuesday, November 14 at 4:00 pm**
  **Library Tour for Kids**
  Join us at Maxwell Library for a tour. Ms. Karen will show the kids around the library and give out interesting information. Recommended for ages 6-11. Registration is required. Call us at 706-793-2020.

- **Friday, November 17 at 3:30 pm**
  **Secret Message Game**
  Join Maxwell Library as we continue to celebrate Picture Book Month. We will read a picture book and play a game that is based on the story and incorporates math as well. Recommended for ages 6-11. Registration is required. Call us at 706-793-2020.

Young Adults

- **Monday, November 6 at 3:30 pm**
  **Wood Craft Cutting Board Designing for Teens**
  Join us at Maxwell to design your own cutting board for cooking. Recommended for ages 12-17. Registration is required. Call 706-793-2022

- **Thursday, November 16 at 2:30 pm**
  **Journaling for Teens** Join Maxwell Library as we discuss the benefits of journaling for teenagers. First journal will be provided by the library. Recommended for ages 12-17. Space is limited. Registration required. Call 706-793-2020.
NOVEMBER PROGRAMS FOR ARGPLS

Young Adults

• Chess Wednesdays
   4:00 pm - 5:00 pm
   Come with a partner and play a game of chess. Chess board provided.

• November 4 from 11:00 am to 12:00 pm
   Fall Treasure Hunt Saturday
   Come out and join us for a Fall themed treasure hunt. Figure out the riddles to find the hidden prize. You don’t want to miss out on this fun event! Registration Required; 706-736-6758.

• Monday, November 20 at 4:00 pm
   Book Smart
   Join us as we celebrate our love of reading, share your favorite author or book with us. We’ll share books we love, do activities and more. Best for ages 12-18.

Adults

• Thursday, November 2, 9, 16, 30 10:00 am to 11:00 am
   One-on-One Tech Help
   Bring your device - phone, tablet, laptop, etc., - and receive one-on-one assistance from library staff. Registration required due to limited space. Pre-register at 706-736-6758.

Wallace Branch Library

Children’s

• Wednesday, November 8 at 10:00 am
   Preschool Turkey Painting
   Come by Wallace Branch Library to paint a turkey on canvas for Thanksgiving. Call 706-722-6275 for

• Tuesday, November 14 at 10:00 am
   Community Leader Storytime with Realtor Naomi Goolsby
   Join Naomi Goolsby as she reads a book and shares her story of how she became a community leader. Please call 706-722-6275 for more information or to register. Best for ages 0-5.

Young Adults

• Every Wednesday at 3:30 pm
   Teen Game Day  Stop by the Wallace Branch Library on Wednesday afternoons for some gaming fun! Play board games, jumbo tictac toe, and puzzles! Win an afternoon snack to go. Call 706-722-6275 to register. Best for ages 12-17.

• Every Wednesday at 3:30 pm
   Teen Crafts  Stop by Wallace Branch Library on Wednesday afternoons for a fun craft! Call 706-722-6275 for more information. Best for ages 12-17.
NOVEMBER PROGRAMS FOR ARCPLS

- **Wednesday, November 8 at 3:30pm**
  **Teen Turkey Painting**
  Come by Wallace Branch Library to paint a turkey on canvas for Thanksgiving, or make your own special Thanksgiving painting. Call 706-722-6275 for more information or to register. Best for ages 12-18.

### Adults

- **Wednesday, November 8 at 3:30pm**
  **Teen Turkey Painting**
  Come by Wallace Branch Library to paint a turkey on canvas for Thanksgiving, or make your own special Thanksgiving painting. Call 706-722-6275 for more information or to register. Best for ages 12-18.

### Diamond Lakes Library

#### Children’s

- **Wednesday, November 8 at 10:00 am**
  **Preschool Turkey Painting**
  Come by Wallace Branch Library to paint a turkey on canvas for Thanksgiving. Call 706-722-6275 for

- **Tuesday, November 14 at 10:00 am**
  **Community Leader Storytime with Realtor Naomi Goolsby**
  Join Naomi Goolsby as she reads a book and shares her story of how she became a community leader. Please call 706-722-6275 for more information or to register. Best for ages 0-5.

#### Young Adults

- **Every Wednesday at 3:30 pm**
  **Teen Game Day** Stop by the Wallace Branch Library on Wednesday afternoons for some gaming fun! Play board games, jumbo tictac toe, and puzzles! Win an afternoon snack to go. Call 706-722-6275 to register. Best for ages 12-17.

- **Every Wednesday at 3:30pm**
  **Teen Crafts** Stop by Wallace Branch Library on Wednesday afternoons for a fun craft! Call 706-722-6275 for more information. Best for ages 12-17.

#### Adults

- **Wednesday, November 15 at 4:00 pm**
  **Cybersecurity 101 (with Amandla IT Security)** There is an attempted cyber-attack every 39 seconds. Learn how to protect your systems, network, programs, devices and data from cyberattacks by using technologies, processes and controls taught to you by the Amandla IT Security team. Registration is required, please call 706-772-2432 to register.
NOVEMBER PROGRAMS FOR ARCPHS

- **Mondays, Wednesdays, and Fridays 9:00 am - 1:00 pm**
  **GED Classes at your Library!** It’s never too late to get your diploma. Diamond Lakes Branch Library is hosting GED Classes. Registration is through Augusta Technical College’s Adult Education department and classes are held at Diamond Lakes Library. For more information and to register, please call 706-771-4131.

- **Monday, November 6 at 3:30 pm**
  **Getting Started with Kanopy!**
  Did you know that you can stream movies and TV shows for FREE with your library card? Learn how with this introductory class at the Diamond Lakes Library. Registration is required, please call 706-772-2432 to register.

- **Monday, November 13 at 3:30 pm**
  **Intro to Computers - Part C (Microsoft Word)** Patrons will learn how to use the basics of Microsoft Word templates, the Home tab, the Insert Tab, the Layout Tab, and Review Tab. Registration required, call 706-772-2432 to register.

- **Wednesday, November 15 at 4:00 pm**
  **Cybersecurity 101 (with Amanda IT Security)**
  There is an attempted cyber-attack every 39 seconds. Learn how to protect your systems, network, programs, devices and data from cyberattacks by using technologies, processes and controls taught to you by the Amanda IT Security team. Registration is required, please call 706-772-2432 to register.

- **Monday, November 27 at 3:30 pm**
  **Intro to Computers - Part D (The Internet)** Patrons will learn how to access the internet, how to tell whether a site is secure or not, and to navigate search results for the information requested. Registration required, call 706-772-2432 to register.

**Follow Us On Our Socials!**

- [Facebook](https://www.facebook.com/Augusta-Richmond-County-Public-Library-System)
- [Instagram](https://www.instagram.com/augustagalib)
- [YouTube](https://www.youtube.com/Augusta-Richmond-County-Public-Library-System)
- [Twitter](https://twitter.com/augustagALib)

- [Newspaper](https://www.newspaper.com/Augusta-Richmond-County-Public-Library-System)